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Note 
Using a video exposure monitoring system as described in this manual, may allow you 
to visualize worker exposures in a video of them conducting their tasks.  See Figure 2, 
Figure 3, and Figure 4 for examples of what still images of a video may look like. 
 
The guide is intended to give an overview and step-by-step instructions to develop a 
video exposure monitoring system and produce high quality video footage for training, 
exposure assessment, and control evaluation purposes. The system described in this 
document uses software that as of June, 2021 was free for download, though 
depending on which software package you choose to use, you may need to purchase 
another software program or upgrades for more functionality, though there are free 
options.  This guide will step you through the use of each of these products on a PC 
running Windows 10 and discuss pros and cons of their use.  The use of these or other 
products was not investigated for Apple products, though one of the software packages 
says that their product will run on Mac computers using an app that allows the user to 
simulate a windows environment. 
 
This guide will not step you through the installation of the software, but will help you 
use it.  For specific errors and problems, each section also contains a link to the 
manufacture/distributor’s manual or help center. 
 
In late August 2021, it was discovered that one software solution with a great 
deal of potential for video exposure monitoring, DashWare, will no longer be 
updated and supported by its owner, GoPro.  The documentation for this 
program will still be presented in an Appendix A as a legacy program, but a 
newer solution, RaceRender, has also been detailed below. 
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Overview 
Video exposure monitoring (VEM) is a method used to animate and overlay real-time 
worker exposure data onto a video of the worker conducting their job while their 
exposure was being monitored.  This combined video is recorded and can be used to 
educate workers and management about where and how exposures are occurring, help 
industrial hygienists better understand how an exposure is occurring, and evaluate 
controls. 
 
The system described in this document has three basic components, a digital video 
camera, a real-time air monitoring instrument, and computer software to animate and 
overlay the data onto the video and to capture the output video.  The first two elements 
can be relatively generic, but within certain bounds.  The software is very specific, but 
three options, EVADE 2.3, RaceRender 3.7.3, and DashWare (legacy software presented 
in Appendix A), will be discussed. 
 
The anatomy and flow of a basic VEM system can be seen in Figure 1. 
 

 
Figure 1 Basic video exposure monitoring system and flow. 

Task/scene selection 
Before considering the equipment needed for conducting a VEM, the task or scene that 
is desired for exploring should be considered.  There are a number of issues to consider 
when shooting VEM footage.  Some of these issues are listed below: 
 
 

RTI

In the Field

Download data files, 
Download video files

DV

DV

RTI

Back at the Ranch

Edit?

Run program to animate data and 
overlay to video (RaceRender,  
NIOSH EVADE, DashWare)

Capture the overlaid video (RaceRender, 
DashWare or other software – OBS Studio 
(free), Camtasia ($$), Snagit ($)
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1. Thoughtfully choose the task to record.  Ones that are amenable to video exposure 
monitoring will have an exposure of interest that varies over time, on a timescale 
that can be evaluated by the instrument and video, and that timescale is of interest. 

a. If exposures change quickly and are “peaky” (less than 1 second or even 
every few seconds), your instrument may not be able to measure differences 
due to its inherent response time and synchronizing the exposure data with 
video will be very difficult. 

b. If exposures vary on a long time frame (once an hour), be sure to capture 
both high and low exposure conditions and the transition time.  If you are 
not able to capture the transition, you can edit the video to show both 
conditions. 

c. Evaluating a job with and without controls can be an effective use of VEM. 
2. Choose an effective filming location with respect to the task.  Film from a location 

from which you can see what is causing the worker’s exposure to change.  Ensure 
that lighting is adequate and you are not too far from the worker.  Some 
practitioners like to use a body-cam approach, so the you see the work from the 
workers’ perspective. 

3. Ensure that you are filming from a safe location as you may not be paying attention 
to your surroundings.  

4. Film the work through a number of cycles of the job.  You will be able to capture 
potential variability in the work.  You can always edit the video afterwards, but 
remember that the duration that someone (your audience) can watch another 
person doing the same job repeatedly, is limited.  Collect more footage than you 
need because it is easier to edit unwanted scenes than go back and collect more 
VEM video. 

5. Take notes of activities (yours and the worker’s) and time. This will allow you to 
interpret your data and video more accurately.  Having a form with time and activity 
columns works well for this. 

 
Some observations to be recorded are:  

• “On time” for video and instrument 
• Synchronization time (s) 
• Task activities 
• Activation/deactivation of exposure controls 
• Stop time for video and instruments 

 
Video recording 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Important things to remember:   
• Ensure that you have adequate battery life to record your video, using 

extra batteries and/or an AC plug for the camera will help. 
• Ensure that you have enough storage on your media to record your 

video.  This will be very dependent on the video camera and the 
resolution and format that you are recording.  It may be helpful to do a 
test run to see how much storage 10 minutes of video takes up.  It is 
possible to bring extra storage cards. 

• Synchronize the clock on the camera and the instrument to the best of 
your ability. 

• Using a tripod will greatly improve your video quality. 
• Try not to zoom in or pan too much when recording your video. 
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Choice of video camera 
Most digital video cameras can be used to collect the video for a VEM, but it should be 
able to record video at the appropriate aspect ratio for a computer screen (cell phone 
isn’t great), high resolution, and a frame rate of at least 24 or 30 frames/sec.   
 
Note: RaceRender also has the ability to use 360o video from a camera such as the 
GoPro Max. 
 
Set up and use of video camera 
The video camera should be set up to record to a file of the appropriate format (see 
Downloading of video) to be used for your VEM project.  If the camera you use records 
to a format that is not supported by your software, there are a number of programs 
that can convert one format to another. 
 

• Set the clock of you video camera as best you can. 
• Remember that if you record footage with the date and time stamp and/or time 

increment, that will appear in your video and be distracting and may be difficult 
to remove. 

• Ensure that you have adequate storage media for the length of footage that you 
will be collecting. 

• Ensure that you have adequate power (extra batteries or AC power supply) to 
collect your desired length of video. 

• Ensue that there is adequate lighting to collect the video.  You may be able to 
either adjust the lighting or adjust the camera for the conditions.  Beware that 
operations such as hot work and the handling of molten materials may 
overwhelm the video camera’s optical sensors. 

• Ensure that the white balance is appropriate for the lighting. 
• Use a tripod whenever possible.  If the worker moves between multiple stations, 

you can move the tripod with them and edit out the transition periods. 
• Zoom in or out prior to filming to capture the elements that you want to 

highlight.  Be aware that zooming out too much may prevent people from 
seeing details and zooming in too much will prevent people from seeing the 
surrounding situation.  If you film too widely, it is possible to correct that during 
the editing.  If you zoom in too much, you can’t correct that. 

• Be careful of dust and moisture getting on your camera and lens.  Moisture may 
not always be benign water.  Dust can scratch lenses, so blow and wipe off 
carefully.  An enclosure can be used, but if it covers the lens, it may impact the 
image quality.  An enclosure may also alter the audio quality. 

• When capturing video, be aware that unless you have an external microphone, 
the camera you are using will be picking up the audio and it is most likely that 
the videographer is closer to the microphone than the worker, so what gets said 
behind the camera is picked up better than what the noise worker is making.  
Many video cameras can be used with either wired and/or wireless microphones 
that the worker can wear. 

• It is recommended that test footage and audio be collected to ensure that all 
settings will make for a good video.  It is possible to adjust video and audio 
settings in the editing process, but some things cannot be adjusted very well. 

• The video should be started prior to starting the data collection instrument. 
 
 
 
Downloading of video 
If the video is too long, your camera may partition the video into multiple files. 
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Try not to reduce the resolution or file size of your videos until you have a final VEM 
product.  Video file formats that are acceptable to the different software solutions are 
discussed in the respective sections of the manual.   
 
Because video files are typically very large, you may need to use an external hard drive 
to store your video.  It may be possible to store the video on a cloud-based service, but 
be aware that some services reduce the file size, which may impact video resolution.  
Store your raw videos in one location because you may have edited or smaller versions 
and you want to keep the originals if anything happens to the edited versions. 
 
Data collection 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
The choice and use of an appropriate instrument to collect the data for your VEM 
project is critical to the success of your project. 
 
Instrument choice 
Choose an instrument that will be able to measure your contaminant of concern, or a 
surrogate of that contaminant.  We have used total particle monitors as a surrogate to 
measure airborne lead, welding fume, and hexavalent chromium and a photoionization 
detector (PID) that measures total volatile organic compounds (TVOCs) has been used 
as a surrogate for various specific solvents.  It is also possible to show noise exposures 
with VEM using a noise dosimeter with this method.  In choosing an instrument, the 
following attributes are important to consider: 
 

• A short data logging time, 1 data point per second is adequate. 
• A short response time.  This is important and may impact your ability to 

synchronize the data and the video.  If the response time is very consistent, it 
may be possible to offset your video to take this into account during the 
synchronization. 

• Passive samplers, especially with long response times, will tend to make it 
difficult to see what is causing the exposure of concern. 

• Long sampling lines with relatively low flow rates may also slow down the 
response and should be avoided. 

• The instrument should have adequate storage capacity to store your logged data 
at the desired logging rate.  Some instruments will allow you to choose different 
parameters to store.  Limiting these can save storage space. 

• Ensure that you have adequate battery time to conduct the monitoring that you 
desire. 

• An instrument with poor data resolution and range may be difficult to use 
effectively. 

Important things to remember:   
• Ensure that you have adequate battery life on your instrument to 

collect the desired data. 
• Ensure that you have enough storage on your instrument to record 

your data at a high time resolution, typically 1 s.  This will be very 
dependent on the instrument and how you have set it up. 

• Set the clock on the instrument to the best of your ability.  Try to 
synchronize the clocks of you video camera and instrument.  This is 
very helpful but not critical.  There will be other ways to synchronize 
the data and the video. 
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• Be aware of your instrument’s limit of detection with respect to your expected 
exposures. 

 
Instrument setup and operation 
If the instrument is not setup and operated properly, the data that you collect (or don’t 
collect for that matter) won’t allow you show what you want to show with your VEM 
project. 
 

• Zero and calibrate your instrument prior to and after your fieldwork.  If the post 
calibration is off, this may indicate that you may need to adjust the data.  This 
can be done after you’ve downloaded the data file. 

• Do a test data collection run to ensure that the setup of the instrument is 
correct. 

• Ensure that the battery is charged or has been replaced with fresh batteries. 
• Clear the memory so there is adequate data storage for your project. 
• Program the instrument to log data at 1 second intervals, if possible. 
• The instrument’s clock should be set prior to sampling to ensure that it is 

correct.  Be aware that computer clocks may not show the correct time unless 
they’ve been updated recently. 

• When you turn on the instrument for your project, try to do it in view of the 
video camera. 

• For the most part, to view worker exposure, the real-time instrument should be 
worn by the worker to sample from their breathing zone, but there are situations 
where an area or fixed monitor can be used. 

• If possible, focus the video camera on the instrument’s output.  This way, you 
can try to synch the instrument’s first data point with the video.  If this is not 
possible, you will be able to synch the video and data at another point. 

• Synchronizing your data and video are very important to have a meaningful VEM 
project.  Instructions on this are found in “Start the recording” section. 

 
Starting the recording 

1. Record detailed start times of the camera and instrument. Times should 
include seconds, if possible. 

2. Start the video recorder. 
3. Start the instrument in its data logging mode. 

Synchronization 
Synchronizing the data stream and video stream is critical to have a meaningful 
end product.  If you’ve ever seen a dubbed movie, you may have noticed that 
the audio may not be exactly synchronized with the video.  That is what we are 
trying to avoid.  Thus, it is very important to synch your video footage with the 
data that are collected.  In the ideal world, the clocks on the camera and 
instrument could be matched up, but often times that doesn’t work because they 
don’t all keep time very well.  In addition, some may have lower resolution in 
time than is needed, making it difficult to set them precisely.  The following 
steps will outline a general method that can be used to synchronize the two 
signals.   
 
For this method, you will expose your instrument to whatever it is measuring or 
a surrogate for a brief period of time while you are logging data and recording 
video of you doing the brief exposure.  Later you will be able to line up or synch 
this mock exposure and the video of you introducing the material to the 
instrument. 
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1. For this step you will need a source of the contaminant that you are 
measuring or a surrogate that can be applied quickly and easily to the 
instrument.  Examples of such are listed below for specific types of 
instruments: 

a. Photoionization detector (Total VOCs) 
i. Bottle of rubbing alcohol 
ii. “Sharpy” marker 

b. Dust monitor 
i. Clapping a dusty rag 
ii. Smoke tube 

c. Noise 
i. Clap with hands 
ii. Whistle 

2. With both the video and instrument recording, hold the instrument in front of 
the camera and quickly expose the instrument to your bolus of contaminant.  
You will see this peak in your logged data and see in the video when it 
occurred.   

3. To assist the process, if possible turn the instrument’s readout toward the 
camera so the camera can record the numeric readout, which will help in the 
synchronization. 

4. If it is not possible to have the camera record the instrument’s numeric 
response, verbally mark when you are exposing the instrument, so you can 
synchronize on the voice cue. 

5. Be sure to record on your observation log when you are exposing your 
instrument to your source of contaminant. 

6. It may be helpful to do the synchronization at the beginning and end of a 
project. 

 
 
Downloading data 
 

1. Follow the instructions from your instrument to download the logged data. 
2. Depending on the instrument, the data may be in a txt, csv (comma 

separated variable), xls, xlsx, or proprietary file format.  Instruments with 
proprietary formats typically allow the user to export the data to an Excel, 
csv, or txt file. 

3. The different overlay software solutions can use different file types, but both 
can use *.csv files. 

4. Microsoft Excel can be used to alter your data and export to the various file 
types as needed. 

5. You may need to simplify the data file to have only time in the first column 
and the measured data in the second column with no headers.  Specific data 
and file formatting requirements will be discussed in the program specific 
sections. 

 
Note: Some programs output the time or concentration into data into an Excel or csv 
file with a leading blank character.  This may make the entries look like real data, but 
will be read as a text field.  This can be changed by removing all of the spaces before 
the number or time. 
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Post processing 
 

 
 
Overlay software 
This manual details three software products that can be used to animate your data and 
overlay the animation upon your video.  All products, EVADE (developed by NIOSH), 
RaceRender (RaceRender), and DashWare (DashWare) and are currently available for 
free and run on the Windows 10 operating system.  NIOSH’s EVADE is only available on 
a Windows platform.  RaceRender is available on a Windows or Mac platform and has a 
very usable free version, but can also be purchased (<$60) if one needs more flexibility 
and features.  “DashWare is a Windows PC application, but [the developer says that] it 
also runs on Macs under VMware, Parallels or Boot Camp.”  Each program has its own 
advantages and disadvantages.  In the following sections, we will attempt to describe 
each system to allow the user to choose and apply the best system for their specific 
application. 
 
Because DashWare is a legacy program, it is covered in detail in Appendix A. 
 
 
Editing videos 
This manual will not cover the editing of either the raw video used for the project or the 
end product video.  A variety of Windows 10 apps have basic video editing capabilities 
and there are YouTube tutorials showing how to do this. 
 
Resources 
This manual, demonstration data and video, and template and project files can be found 
on our website at https://deohs.washington.edu/FRCG/project/VEM.  

Important things to remember:   
• It is important to have data and video that have been collected with 

synchronization in the filming stage to develop a meaningful VEM product.  If 
not, there will be much head scratching in the post processing phase. 

• Using a powerful computer with much hard drive space and RAM will make 
processing of the video easier. 

• A solid-state external hard drive is an excellent option for this application. 
• Remember to use full resolution video in the post processing and reduce the 

resolution afterward to maintain image quality. 
• Prior to doing the overlay, consider what you will be using the video for 

because that may dictate which software product you use. 

https://www.cdc.gov/niosh/mining/Works/coversheet1867.html
https://racerender.com/RR3/Features.html
http://www.dashware.net/
http://www.vmware.com/
http://www.parallels.com/
http://www.apple.com/support/bootcamp/
https://deohs.washington.edu/FRCG/project/VEM


  
  

Table 1 Comparison of Overlay Software Products. 

Parameter EVADE RaceRender DashWare 
Version 
evaluated 

V 2.3 V 3.7.3 V 1.9.1  

Source https://www.cdc.gov/niosh/mining/
Works/coversheet1867.html  

https://racerender.com/RR3/Features.html  http://www.dashware.net/ 

Operating 
system tested 

Windows 10 Windows 7, 8, or 10, though 64 bit 
Windows 10 recommended. 
MacOS 10.9 or higher 

Windows 10 (probably iOS) 

Shows past and 
future 
exposures 

Yes Yes Possibly 

Image of final 
product 

Figure 2 Figure 3 Figure 4 

Record final 
product to video 

Need to use 3rd party software such 
as OBS Studio (free) or 
Snagit/Camtasia ($) 

Done via RaceRender Done via DashWare 

Flexible display A little Yes Yes 
Display data 
directly on video 

Yes, with little flexibility Yes, with much flexibility Yes, with much flexibility 

Pro’s • Very easy to use 
• Little training required 
• Can see history and future of 

data 
• The EVADE file with synched data 

and video can be viewed by 
others with the EVADE program 

• Relatively easy to use 
• Little training required 
• Can see history and future of data 
• Very flexible in the type of data display 
• More video file formats can be used 
• More vivid display of data 
• Records overlay as an output video 

• Very flexible in the type of data 
display 

• More video file formats can be 
used 

• More vivid display of data 
• Records overlay as an output 

video 
Con’s • Display is not really adjustable 

• Few display options 
• Does not record overlay as a 

video, need 3rd party software 

• Synchronizing can be tricky 
• Need to pay ($40-$60) to be able to 

output longer than 3 minutes at once, 
have advanced gauge editing, and be 
able to remove the RaceRender logo. 

• Requires more work and/or 
templates to make the flexibility 

• More difficult to learn 
• Little technical support 
• Is a legacy product 

 
 
 

https://www.cdc.gov/niosh/mining/Works/coversheet1867.html
https://www.cdc.gov/niosh/mining/Works/coversheet1867.html
https://racerender.com/RR3/Features.html
http://www.dashware.net/


  
  

 
Figure 2  Image from the EVADE program. 

 
Figure 3  Image from the RaceRender program. 
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Figure 4  Image from the DashWare program. 
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EVADE 
 
This manual assumes that you have been able to download, install, and run the 
software correctly from NIOSH at: https://www.cdc.gov/niosh/mining/Works/coversheet1867.html.  
NIOSH also provides a tutorial to help you deploy their product. 
 
EVADE is a relatively straightforward program that allows you to quickly develop a VEM 
system.  There are not many options, but that is what makes it straightforward to use.  
We have developed a project file with demonstration video and data that are available 
to you on our website (https://deohs.washington.edu/FRCG/project/VEM) so you can 
quickly start a project.  The readme.txt file will instruct you where these files should be 
located.  This manual will help you understand the basics of EVADE to allow you to use 
these files and develop your own VEM, but will not go into details.  For more 
information, EVADE has online resources to help you. 
 
 
File requirements 
The file requirements for the EVADE package are shown in Table 2. 
 

Table 2 File requirements for EVADE 

 Requirement 
Video WMV, AVI, MP4, MOV, and possibly 

others 
Data Generic CSV file or some instrument 

specific files [Airtec Diesel, AM510, 
AM520, Nanozen, pDR1000 and 
pDR1500] 

 
The data format for input into the EVADE system, if using a generic CSV file, should 
have time in the first column and measured values in the second column.  This could 
also be done using one column with the types of data separated by a comma.  No 
column headers or titles should be used with either format. 
 
Time should be in one of the following formats with no date: 
 

hh:mm:ss, or hh:mm, or hh:mm:ss.ssss 
 
The measured values should be formatted as an integer or floating point decimal. 
 
Starting a Project 
To start a project using NIOSH EVADE, you’ll open the program, add a data channel and 
a video channel, synchronize them and then run the program.  The sections below will 
step you through this process.  To record to a separate video for future use, you’ll need 
to use a 3rd party software solution.   
 
Demo Files/Folders 
To help you get started on a project in EVADE, we have made some demo files available 
for you to download on our website.  These files and folders are shown in Figure 5. 
 
 

https://www.cdc.gov/niosh/mining/Works/coversheet1867.html
https://deohs.washington.edu/FRCG/project/VEM
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Figure 5 Demo files to start using EVADE 

 
 
Adding Data and Video 
To start a new project, you’ll need to first make data and video channels and input 
those respective files.  Following are the steps.  We have also provided a demo project 
file for you to investigate (EVADE_Demo.dcf2).  You can also use the demonstration 
video and data files that we provide. 
 

1. Click on the “Add File” icon in the upper left corner of the program (Figure 6) 
and add a new channel.  You can start with either a video or data channel.  The 
manual will start with a video channel and you’ll be prompted name the channel 
and to select a video file.  This manual uses a file called DemoVideo.mp4. 

 

 
Figure 6 Add files/channels 

The Project Editor (upper left hand box in the program) will look like Figure 7.  Next, 
you will add a data channel.  To do this, you’ll click on the same Add File icon/New 
Channel, but select “Log” from the two options.  It will then prompt you to name the 
data channel, this manual named the channel DemoData, and allows you to choose the 
type of data being imported.  If you choose “Concentration”, it will allow you to import 
your data directly from a proprietary data file from one of the instruments listed in 
Table 2, in addition to a CSV file.  If you select “Generic”, you will only be allowed to 
import a CSV file.  Responses of “Light” and “Noise” will allow you to enter those 
respective types of files as well.  If you are using a CSV file, using Generic is the least 
confusing way to import the data. 
 

 
Figure 7 View of Project Editor with an added video file. 

This selection will then allow you to choose your file and assign units to your 
measurements (Figure 8).  You can press the Preview button to verify that your data 
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are being interpreted correctly.  After adding your video and data files, the program 
windows will look similar to Figure 9.  Now save your project by clicking on the small 
telescope above “Add File” (Figure 6).  You can view your product by pressing the “Play” 
button at the top of the screen.   
 

 
Figure 8 Window for entering the data source and units. 

 
You will now be able synchronize and slightly alter the look of your video and data.  In 
this processing, if you happen to delete your data file from your data channel, it is 
easily added back by clicking on Add File and then choosing your data channel and then 
reselecting your data file. 

 
Figure 9 Four program windows after video and data have been added. 

 
To highlight specific areas in your video, bookmarks can be added, saved and annotated 
at a variety of locations in your end product. 
 
To adjust the look of the data chart, you can click on the Data Window and then click on 
the Options gear at the top of the screen.  The window shown in Figure 10 will open.  
This will allow you to add a line indicating a threshold for your exposures. 
 

[Project Editing Window] [Project Editing Window] 

[Bookmarks Window] [Data Window] 
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Figure 10  Options available for adjusting the look of the graph. 

 
To add an animation of your data directly to the video channel as a semi-circular gauge, 
select the window with the video channel (Project Editing Window) and click the Options 
gear at the top of the screen.  The window shown in Figure 11 will open.  You will then 
select Add overlay at the bottom left and choose the options at the right, and click 
Apply.  A data gauge will appear on the bottom right of your video channel window.  
This gauge will only show the exposure at the current time of your video. 
 
 
 

 
Figure 11  Options available for overlaying data directly onto the video. 

EVADE also allows for basic analysis of your data.  To do this, you will first click on your 
data window and then on the “Add Analysis” icon at the top of the screen.  The windows 
shown in Figure 12 will pop up for your selection of options.  The selected analyses will 
be shown in the Analysis tab of the data window. 
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Figure 12 Options available for data analysis (left panel shows the initial window and the right 
panel shows the options for the analyses). 

 
By clicking on the down arrow and the “push pin” in the upper right hand corner of each 
window (Figure 13), you’ll be able to adjust the look of the different windows.  This 
manual will not describe that process. 
 
 

 
Figure 13 Adjusting the location and sizes of the windows 

 
Synchronizing the Data and Video 
After you have your project set up, you may need to synchronize your data and video.  
This can be done by going to the Project Editing Window and clicking on the bar labeled 
with your video or your data and dragging the bar so the data and video are synched.  
This can also be done by adjusting the “Segment start time” with the up and down 
arrows in the Selected segment bar that shows up after selecting one of the channel’s 
bars (Figure 14).   
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Figure 14  Editing the synchronization of the data and video. 

 
For additional help visit: 
https://www.cdc.gov/niosh/mining/Works/coversheet1867.html 
 
Running the Overlay 
After you have set up the panels with the look that you want and have synched your 
data, be sure to save your work.  This *.dcf2 file can be shared with others who have 
EVADE.  If you desire to share your work as a video file, you will want to capture the 
data and video screens using a 3rd party video capture program, such as OBS Studio or 
Camtasia/Snagit. 
 
 
 
 
Recording the Overlay Video 
OBS Studio 
 
OBS Studio is “free and open source software for video recording and live streaming”, 
that has been designed to operate on Windows, Mac OS 10.13+, and Linux and can be 
downloaded from https://obsproject.com/.  This manual will only cover its operation on 
a Windows operating system to record an EVADE session.  OBS works best with 
multiple monitors - one running OBS and the other running EVADE. 
 

1. Start OBS on one monitor (if possible) 
2. Start EVADE on the second monitor (if possible) 
3. In OBS, ensure that there are no Sources currently listed.  If there is one, you 

can delete it by highlighting it and pressing the “-” button below the Source list 
(see Figure 15). 

4. Add a Window Capture Source by clicking on the “+” and then Window Capture.  
This will allow you to choose a window from which to capture the action.  You 
will be given the option to choose a window to record (Figure 16).  Here you can 
choose EVADE.  You may need to close and reopen EVADE for it to be 
acknowledged by OBS. 

5. It is recommended that you unclick, “Capture Cursor”. 
6. The size and location of your recorded window can be altered by grabbing the 

red box seen around your window and moving and resizing it (Figure 18). 
7. To crop the window, right click on the Windows Capture source and click Filters.  

This will open a window where you can add or remove filters.  Add a Crop/Pad 
filter and you will be able to adjust the cropping of the window (Figure 19). 

8. For the example used to develop this manual on this computer, we used a 
cropping of Left: 1400, Top: 250, Right: 12, Bottom: 50.  Depending on the size 

https://www.cdc.gov/niosh/mining/Works/coversheet1867.html
https://obsproject.com/
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of your computer monitor and layout in EVADE, you may need different crop 
settings. 

9. Once you have set the crop settings, you can move or resize the window in OBS. 
10. You can also adjust the size and shapes of the windows within EVADE, but that 

won’t be covered in this manual. 
11. You can now record your video by clicking on the “Start Recording” button at the 

bottom right.  Next go to EVADE and start playing the video and data.  While 
you are recording, a red circle will be shown at the bottom and the Start 
Recording button will turn to a Stop Recording button.  An *.mp4 file will be 
saved of your recording by default in your Videos folder. 

12. To change the location for saving files, go to Files/Settings/Output. 
13. Depending on the memory of your computer, the output video may or may not 

be choppy.  It may help to close as many programs as possible to reduce this 
issue. 
 
 

 
 

 
Figure 15  Editing sources for OBS. 

 

 
Figure 16  Choosing a window to record. 

 
Figure 17  Start and stop recording. 
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Figure 18  Recording window in OBS. 

 
Figure 19  Cropping the window. 

 
Camtasia/Snagit 
Another alternate to capture the video is to use a screen/video capture software 
solution such as Snagit (Techsmith).  This package allows you to highlight an area on 
your computer screen and capture either still images or video with audio.  The following 
are the steps to use Snagit to capture a video from an EVADE overlay session. 
 

1. Have your EVADE overlay session set up to your liking. 
2. Run the Snagit program 
3. Configure the recording as in Figure 20.  If you use the settings shown in this 

figure, the Editor will open the video when it is done processing and this will 
allow you to save it to a location of your preference. 

4. Maximize the EVADE window (Snagit will go into the background) and make sure 
that the project is at the beginning. 

5. Click on the Snagit icon on the bottom task bar to bring it on top of the EVADE 
window 

6. Click on the red “Capture” button.  This will bring up the crosshairs to allow you 
to select the area that you would like to capture for the video.  Click and hold 
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while you find one corner and drag the box to the opposite corner.  Let go and 
you will have defined your recording area.  The recording control panel will also 
pop up Figure 21. 

 

 
Figure 20  Control panel for Snagit. 

 

 
Figure 21  Control panel for Snagit recording. 

 
7. To start the recording press the white circle in the red square.  This will give you 

a 3 second countdown.  After the countdown, you will be recording whatever you 
selected on your screen. 

8. Now press the blue “Play” button on EVADE’s control panel.  This will start your 
overlay video playing while Snagit is recording. 

9. Once your EVADE overlay has completed playing, press the Snagit stop button 
(white square on blue background).  Your video will process for a few moments 
and then be opened in the Snagit Editor.  This will allow you to save your video 
as an MP4 video file, which can be edited in your favorite video editing program, 
if desired.  
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RaceRender 
 
RaceRender is a program that was written to allow people to overlay their 
auto/motorcycle racing data onto action cam videos of the racing.  The following link 
shows an example video: https://www.youtube.com/watch?v=WeUSOmfLqiU&t=151s  
(Buckle up).  The program can be easily adapted for use with exposure data. 
 
This manual assumes that you have been able to download, install, and run the 
software correctly from RaceRender at: https://racerender.com/RR3/Download.html.  
The free version of RaceRender, allows you to develop a basic, short video (<3 mins).  
To be able to have more flexibility in the look and length of your video, you may need 
to purchase one of the upgrades.  See Appendix B for a comparison table of the 
features and costs as of August 2021. 
 
RaceRender is a highly powerful program that allows you to edit previously developed 
gauges.  It can also be used with pre-programmed templates that contain gauges.  The 
basic program comes with many templates, but two have been developed that show 
exposure data and are available to you on our website 
(https://deohs.washington.edu/FRCG/project/VEM) so you can quickly start a project.  
The readme.txt file will instruct you where these files should be located.  This manual 
will help you understand the basics of RaceRender to allow you to use these files and 
develop your own VEM, but will not go into details.  For more information, RaceRender 
has a manual in addition to a number of online tutorials to help you. 
 
Basic terminology 

1. Project – You will have a project file (.rrp) that will include your data, video, 
gauges, and settings.  Unlike EVADE, the video and data files are only linked to 
this file, therefore the project file cannot be used on other computers unless all 
files have been copied onto that computer. 

2. Display Objects – Display objects are entities that you can overlay onto your 
video.  Categories of objects are: Video/audio, Image files, Drawings, Text, and 
Data Visualizations.  These data visualizations are a graphical and animated 
visualization of your data.  It can be shown in dials, bars, map tracks, numbers, 
etc.  Objects are relatively programmable.  Some basic objects have been 
adjusted for showing exposures and are available in the demo templates we 
provide for you (see below).   

3. Template – A template is a file (.rrt) that tells RaceRender what display objects 
to use and where and with what data.  Two demo templates have been 
developed for the demo data with a few different types of objects and are 
available on the website. 

 
Demo Files/Folders 
To help you get started on a project in RaceRender, we have made some demo files 
available for you to download on the website.  These files and folders are shown in 
Figure 31. 
 

https://www.youtube.com/watch?v=WeUSOmfLqiU&t=151s
https://racerender.com/RR3/Download.html
https://deohs.washington.edu/FRCG/project/VEM


 

28 
 

 
Figure 22  Demo files to start using RaceRender 

 
Data/Video - The folder Data_Video has two files, a basic CSV file with time, 
concentrations, and noise data (both are made-up), and a short video clip saved as an 
MP4 file.  This folder can be copied to anywhere on your computer.  When you open the 
RaceRender demo project, it will prompt you for the locations of your data and video 
files. 
 
Template – The *.rrt files in the folder should be copied into the folder 
C:\Users\XXXXXX\Documents\RaceRender 3\Templates, where XXXXXX is your profile 
name on the computer.  Depending on your setup, this RaceRender 3\Templates folder 
may be in a different location.  It should be noted that the files don’t need to be placed 
in this location, but if don’t copy them there, you will have to locate them whenever you 
open a template. 
 
Project – The project files RR_Conc_Demo.rrp and RR_Noise_Demo.rrp can be copied 
to anywhere on your computer. 
 
README file – The README.txt file has these instructions. 
 
 
File requirements 
The list of video and data file types acceptable for use with the RaceRender package are 
extensive and shown in Appendix C.  The data format for input into RaceRender, if 
using a CSV file, should have time in the first column and measured values in the 
sequential columns.  Figure 23 shows the format for the demo data provided to you.  
Column headers or titles should be used. 
 
Time should be in one of the following formats with no date: 
 

hh:mm:ss or ss.ss 
 
 
 
 
 
 
 
 
 

Figure 23  Format and content of CSV data file 
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Starting a Project 
For this manual, we will step you through starting a new project without a template and 
then add the template later.  A template allows you make new overlay projects quickly 
if you have developed a set of display objects that you like.  Starting a new project 
without a template will allow you to have a better understanding of how RaceRender 
works.  You can also just open one of the demo project files to get going. 
 

1. Start the RaceRender program. 
2. When the program opens, click the Blank Project button at the bottom of the 

New Project Menu page.  What you see here are project templates that 
incorporate data templates and well as different video views.  We will not use 
these. 

3. Now that you have a blank project open, go to Input Files on the right hand side 
of the screen and “Add” both your data (DemoDataRR.csv) and video 
(DemoVideo.mp4) files.  This can be done at the same time by selecting both 
and clicking “Open”.  It will prompt you for a Data Overlay Template, “Cancel” 
that screen. 

4. In the Input Files box, you will see both of your files.  Double-click on the data 
file or highlight the data file and click the Config button above the file names.  
This will open the File Information & Settings window, as seen in Figure 24. 

5. Change the Session Time pull down to “Time” from “(Automatic)” and then find 
Vehicle Speed (on the left in the middle) and change it to “Conc” or “Noise” from 
“(Automatic)”, then click OK.  This will allow your data to be interpreted 
properly. 

 

 
Figure 24 File Information & Settings window.   

6. Next, you will need to add objects.  This can be done by either clicking on “Add” 
under Display Options on the right side of the screen or by adding a Template 
via the main dropdown menu by selecting “Add Template to Project…”. 

  



 

30 
 

 
Using Data Templates 
If you decide to use one of the data templates that we provide for exposure 
assessment, you will have several different types and orientations of display objects to 
choose from.  Each of these objects can be modified to meet your specific needs.  
Guidance for modifying objects can be found in the next section of this manual. 

1. After you have your data and video open in RaceRender, go to the main 
dropdown menu item File\Add Template to Project… and scroll through the 
options until you find “Data – Exposures Conc” or “Data – Exposures Noise”.  If 
you can’t find the templates, make sure that you have copied the template files, 
that we provide you (Data – Exposures_Conc.rrt and Data – 
Exposures_Noise.rrt) into the folder C:\Users\XXXXXX\Documents\RaceRender 
3\Templates.  See the Demo Files/Folders section above for more details. 

2. Once you click on the template your project, it will try to connect your data to 
the objects.  If this isn’t correct, you can change it. 

3. As set up, the Conc template uses the Conc field in the demo data file and the 
Noise template uses the noise data in the demo data file.  This was done for 
your convenience because as you will see, it is relatively straightforward to 
change a template once it is set up. 

4. If you’ve used the field names “conc” and “noise” for your data, the gauges 
should already be attached to your data if you have chosen the correct template 
for your data.  If you have used other names, you will need to connect your data 
to the objects. 

5. To connect your data to an object or change the data source, either double-click 
the object on the screen or it’s object icon in the Display Objects box, or 
highlight its icon and click the Properties button.  This will open the Display 
Object Properties box. 

6. When the Display Object Properties box is open, find the pull down option called 
Field or Field Y (Figure 25) and select your desired field.  By closing out this 
window (x’ing out), you will save your setting.  You will also notice many, many 
auto racing variables that the system is looking for.  You can ignore these, 
unless you are racing cars or motorcycles. 

7. You may also need to adjust the scale for your gauges, but that will depend on 
the range of your data and the look that you want.  To do so, open the Display 
Object Properties panel, Figure 26, and find Range and adjust the lower and 
upper values of your range.  Depending on the type of gauge, you may also 
want to adjust the colors. 

8. In the templates, you will see six different display objects that you can choose 
from.  They all have different looks and attributes.  Choose which ever one 
suites you needs and delete the others from you project. 

9. Objects can be easily moved and resized. 
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Figure 25  Display Object Properties screen 
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Figure 26 Editing a gauge (top [left] and bottom [right] of Properties panel) and the resultant 
gauge [bottom right] 

 
Making and modifying display objects 
Objects are relatively easy to make and modify using RaceRender.  Depending on the 
version of RaceRender you have (free or one of the paid versions, see Appendix C), you 
will be able to edit some or all aspects of the objects.  When you open Add from the 
Display Objects box, you will see the different options for objects and other 
enhancements (Figure 27).  These options will differ for different types of objects.  The 
data visualizations or objects are general layouts for which one can alter the type of 
data, the size, shape, text, and color amongst other options.  In showing how to modify 
objects, we will highlight the components of a relatively simple bar / Level object, the 
“Bar Light Rect” object.  It should be noted that the round objects have a Gauge 
Designer, which allows you to edit more attributes of those objects, but is only available 
with the more complete versions of the program.  In addition, not all of the editing 
options are available in the free version. 
 
From the title, you can learn that the object we are editing is a rectangular bar gauge 
that is light in color (Bar Light Rect).  This is the object from which we developed the 
VBar/Gradient and HBar/Gradient objects and is shown on the bottom right of Figure 
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26.  As an example, we will discuss the elements of this object that can be edited. For 
different object types, there may be different options, but they are all relatively similar.  
Table 3 describes the elements and what they do for a bar graph. 
 
Table 3 Editing gauge elements in RaceRender 

Parameter Description 
Time You can program the gauge to have different appearances 

at different times in your video.  You will need to use the 
Timeline feature to help see where things change. 

Type The Type is set when you add a gauge and can’t be altered. 
Edit Background You can edit the background of a gauge. 
Active Controls whether the object is currently used. 
Name The name that you give to your gauge. 
Style This is the style of the gauge.  The list given shows 

preprogrammed styles.  If you click on one of these, it will 
change the look of the gauge and you cannot go back, 
unless you reopen the template or readjust the gauge.  
Ctrl-z may work. 

Input This is the input file from where the data will be pulled. 
Field This is the data field that will be used for your display. 
Range The range is the lower and upper values of your data that 

will be displayed.  If you don’t click the boxes, the program 
will choose automatically. 

“Gradient 1” This is an unnamed field.  Along with the two color boxes to 
the right, this drop down allows you to design the look of 
the bar.  Set at “Bar”, the moving bar doesn’t change color 
as it increases.  With this setting the two colors are used to 
make a multi-colored bar.  If one of the “Gradient” settings 
is chosen, one of two gradient styles will be used.  It should 
be noted that the colored box on the left indicates the color 
for the higher values. 

High Res When this is clicked, many of the elements of the graphic 
become higher resolution. 

Thickness Thickness, is actually the width of the graphic. 
Horizontal Horizontal will flip the aspect ratio and have the graphic 

moving from left to right, instead of down to up. 
Reverse Reverse flips the movement of the data display (up to 

down), but be careful because the axis numbering may not 
change. 

Back Back will remove a background color.  The current setting is 
a two tone white and grey.  With Back unchecked, in some 
areas of your gauge, you will see the background video. 

Rounded This will round the corners of your bar. 
Color Change This allows the bar to change colors at a given threshold, 

but didn’t work well for my purposes.  To get a bar to 
change colors without a gradient, as the bar crosses a 
threshold, you may use two separate gauges sitting on top 
of one another.  See the grouped gauges called 
HBar/Split/Green and HBar/Split/Red.  They function as one 
gauge by adjusting the colors, ranges, and locations. 

Trim This alters presence and thickness of the trim around the 
gauge. 
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Parameter Description 
Axis This allows you to add an axis to your bar and the following 

3 attributes can also be altered. 
Interval This is the interval for your crosshatches. 
Numbers This programs whether numbers will be shown on the axis 

and their size. 
Flip Sides By default, the numbers show up on the right side of the 

bar, this will move them to the left side. 
Data Number This will show you the current value of your data and can 

be altered with the following two options.  In addition, the 
number’s color and size can be altered. 

Decimal This allows you to show the value with decimal places. 
Position This allows you to move the number values. 

Label This allows you to place a label on your gauge and alter its 
color size and position.  Be aware that this may squish your 
label and it could be better to add a text object to your 
video so it can be fully seen. 

Position This alters the location of the label 
Display Position 
& Size box 

The options in this box allow you to move your object 
around the screen.  An object can also be grabbed and 
dragged on the screen, if so desired. 

Width Doesn’t seem to work. 
Height You can adjust the height of your object, but it also adjusts 

the width. 
Smaller/Larger The size of you object can be adjusted with the 

Smaller/Larger buttons by the percentage shown to the 
right. 

Maintain Aspect 
Ratio 

Doesn’t work as I think it should. 

Transparency Allows you to make your object solid, invisible, or anything 
in between.  Zero percent is solid and 100% is invisible. 

Flip Image You can flip your object horizontally, vertically, in both 
directions or none. 

Edit Clipping 
Area 

You can use this to show only part of a gauge.  You can use 
this to crop you gauge. 

Color Channels You can R, G, or B to remove those colors from your image. 
 
 
Adding other components 
To add other components to overlay your video, simply click Add, under Display Objects 
and the screen shown in Figure 27 will appear.  Select the type of Object you would like 
to use.  The following describes the basic Object types that can be added: 
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Figure 27 Display options that can be added to a project. 

 
Video / Audio / Image File: You can add a “picture-in-picture” effect by adding 
another video or image onto your main video.  You can also add supplemental audio.  
You can only add extra audio, video, and images to your project if you have already 
added them via the Input Files/Add process.  Once you choose the style of the object, 
you will be able to edit the input, where you can choose the input file you wish to add to 
your video. 
 
Drawing: Here you can either add a shape or text to your video.  These objects can be 
edited to suite your needs.   
 
Object Order: The order of objects in the Display Objects list will determine whether 
they are in front or behind other objects, including the video.  To make text visible on 
top of a non-homogenous background, oftentimes, it is helpful to use an outline for 
your text.  Generally, your video will be on the bottom of the list.  To move objects 
front and back, select the object and click on the Move Up or Move Down buttons on the 
bottom right of the screen. 
 
Synchronizing Data and Video 
In order for your video and data to be effective, the animated data will need to be 
synchronized to the video as best you can.  There are two tools that can be used to 
adjust the synchronization of the two streams, the Synchronization Tool and the Side by 
Side tool.  Buttons for both tools can be found between the Input Files and Display 
Objects panes.  The Synchronization Tool (Figure 28) can be used if you know the 
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duration of the offset that you would like to insert between your video and data.  This is 
a straightforward process.  If you need to view the data and video side-by-side to see 
where the best point for synchronization is, it is best to use the Side by Side tool 
(Figure 29).  The Synchronization Tool will not be discussed further due to its 
straightforward nature.  The following can be used to help you use the Side by Side 
synch tool: 
 

1. In order for you to be able to use the Side by Side synch tool, you will need to 
ensure that your input file is configured.  To do this, double click the icon for 
your data file in the Input Files panel.  This will open the Configure Input File 
panel (Figure 24).  If you don’t have time set and either Conc or Noise in this 
panel, see the previous section on Sarting a Project.  With both of those 
variables set appropriately, you should see a line graph of your data in one panel 
and the video in the other panel, as seen in Figure 29. 

2. Once in this panel, you can either pull either the data’s or video’s slider to 
advance that scene until it corresponds with the appropriate location in the other 
panel.  This can also be done numerically by typing in the time difference that 
you would like. You can also click on the forward or backward arrows with no 
number beneath it, a 2 or a 3 beneath it.  These will advance or reverse the 
scene by 1, 2, or 3 frames.  Standard video is about 30 frames per second. 

3. Press the play button on the right to check the synchronization. 
4. If you don’t see your data presented in a graph, check the value you have for 

Data Display, in the middle of the panel.  If you assigned your concentration or 
noise values to be the Vehicle Speed, the Data Display value should be Speed 
Graph. 

5. There are other ways to synchronize your data which will not be covered here. 
 
 

 
Figure 28  Synchronization Tool panel. 

 



 

37 
 

 
Figure 29  Side by side synchronization panel. 

 
 
The Timeline 
Each of the objects that you have placed in your overlay and in the Display Objects 
panel can have its timeline adjusted.  You can have gauges, text, or other objects 
appear or disappear and predetermined times.  To help control this, you can use the 
Timeline.  To activate this feature, click the Timeline button at the top of the screen.  
The floating panel seen in Figure 30 will appear and can be moved and sized as needed.  
Here you can adjust the duration of the project as well as each object.  If you adjust 
the synchronization, the adjustments will show here. 
 

 
Figure 30  Timeline tool. 

With the Display Objects panel and Timeline, you can also adjust how the different 
objects are seen.  If an object is selected in the Display Objects panel, you can move it 
Up or Down using the Move Up and Move Down buttons at the bottom of this panel.  
Objects at the bottom of this list are used as background layers and those at the top 
are in the foreground of your composite video.  These layers can also be seen in the 
Timeline. 
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NOTE:  It should be noted that the RaceRender Logo will show on your videos unless 
you have purchased the software.  The different purchase levels allow you to shrink, 
shrink and make transparent, or remove this logo.  It will always be at the top of the 
stack of objects. 
 
 
 
Recording the Overlay Video 
Now you are ready to record your overlay video.   
 

1. Click File>Create Video File from Project. 
2. You will have a few options to choose here.  First, pick the Output Profile.  This 

will determine the general size and quality of your file.  For most common 
situations, “Local File: Full High-Def (1080p) is a good selection for a high 
quality video. 

3. Next you can choose the aspect ratio for your video.  This may depend on your 
input video.  Newer computer screens are 16:9 Wide-Screen, but older monitors 
are 4:3 Standard. 

4. You can click on “Show Advanced Settings” to be able to do more fine tune 
adjusting. 

5. In “Step 2”, you can dictate what part of the video to capture. 
6. In “Step 3”, you can balance speed and quality. It is recommended that you 

select Better or Maximum quality. 
7. Click the “Start Rendering!” button and select the name and location for your file 

and click Save. 
8. Sit back and your video will be created. 

 
NOTE: Some video players have difficulty with some video files (or more precisely their 
encoders).  If one doesn’t work for you try again.  If it still doesn’t play the video, try a 
different video player. 
 
Styles: 
You can define the style for your objects so they can be shared with future projects, but 
this will not be covered here. 
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Appendix A  DashWare 
 
DashWare is a program that was written to allow people to overlay their “adventure 
data” onto GoPro videos of them in the act of their adventure.  The following link shows 
an example video: http://www.dashware.net/videos/flytec-wingsuit-jump/ (Hold onto 
your seat). 
 
This manual assumes that you have been able to download, install, and run the 
software correctly from DashWare at: http://www.dashware.net/dashware-download/.  
DashWare is a high power program that allows you to develop your own gauges to 
show your data in the manner in which you want.  It can also be used with pre-
programmed gauges and templates.  These computer resources are available to you on 
our website (https://deohs.washington.edu/FRCG/project/VEM) so you can quickly start 
a project.  The readme.txt file will instruct you where these files should be located.  This 
manual will help you understand the basics of DashWare to use these basic files, but 
will not go into details.  For more information, there are a number of online tutorials to 
help you. 
 
Demo Files/Folders 
To help you get started on a project in DashWare, we have made some demo files 
available for you to download on our website.  These files and folders are shown in 
Figure 31. 
 

 
Figure 31  Demo files to start using DashWare 

 
Data/Video - The folder Data_Video has two files, a basic CSV file with time and 
concentrations data (made up), and a short video clip saved as an MP4 file.  This folder 
can be copied to anywhere on your computer.  When you open the DashWare demo 
project, it will prompt you for the locations of your data and video files. 
 

http://www.dashware.net/videos/flytec-wingsuit-jump/
http://www.dashware.net/dashware-download/
https://deohs.washington.edu/FRCG/project/VEM
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Template – The folder DemoProject_Template [For Templates], should be copied into 
the folder C:\Users\XXXXXX\Documents\DashWare\Templates and delete “[For 
Templates]” from the folder name.  Depending on your setup, this DashWare/Templates 
folder may be in a different location. 
 
Project – The folder DemoProject2 [For DashWare Projects], should be copied into the 
folder C:\Users\XXXXXX\Documents\DashWare Projects, and delete “[For DashWare 
Projects]” from the folder name.  Depending on your setup, this DashWare Projects 
folder may be in a different location. 
 
Gauges – The two folders Exposure – Horizontal [For Gauges] and Exposure – Vertical 
[For Gauges], should be copied into the folder 
C:\Users\XXXXXX\Documents\DashWare\Gauges, and delete “[For Gauges]” from the 
folder name.  Depending on your setup, this DashWare/Gauges folder may be in a 
different location. 
 
Data Profile (file) – The file DemoProfile [For DataProfiles].xml, should be copied into 
the folder C:\Users\XXXXXX\Documents\DashWare\DataProfiles, and delete “[For Data 
Profiles]” from the file name.  Depending on your setup, this DashWare/DataProfiles 
folder may be in a different location. 
 
CustomDataTypes.xml and Settings.xml (files)– These two xml files will add 
concentration and noise data types to your projects.  These files should be copied into 
to folder C:\Users\XXXXXX\Documents\DashWare\Settings.  You will be replacing the 
original settings.xml file with this one.  The file, CustomDatTypes.xml is new.  If you 
wish, you can preserve the old Settings.xml file by renaming it in case you want to use 
that file again. 
 
README file – The README.txt file has these instructions. 
 
 
 
 
File requirements 
The file requirements for the DashWare package are shown in Table 4. 
 

Table 4 File requirements for DashWare 

 Requirement 
Video WMV, MP4, AVI, MOV, QT, MPG, 

MPEG, and MTS 
Data CSV and TXT files (other formats are 

also accepted but their use will not be 
covered here) 

 
The data format for input into DashWare, if using a CSV file, should have time in the 
first column and measured values in the second column, as shown in Figure 32.  
Column headers should be used. 
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Figure 32 Format and content of CSV data file 

 
 
Time should be in one of the following formats with no date: 
 

hh:mm:ss or ss.ss 
 
The measured values should be formatted as an integer or floating point decimal. 
 
Basic terminology 

1. Project – You will have a project file that will include your data, video, data 
profile, and gauges.  Unlike EVADE, the video and data files are only linked to 
this file, therefore the project file cannot be used on other computers unless all 
files have the same locations. 

2. Data Profile – The data profile is a file that tells DashWare how to interpret 
your data.  The profile tells DashWare whether there are headers at the top of 
you data columns, which column has a time variable, and which column has your 
data variable.  A demonstration profile has been written, called DemoProfile that 
will allow a basic data file to be read.  The profile can be edited to allow data 
with a different structure to be read. 

3. Gauge – A gauge is the graphical visualization of your data.  It can be shown in 
dials, bars, map tracks, numbers, etc.  Gauges are highly programmable.  Two 
basic colored moving bars have been developed for showing exposures.  One is 
horizontal and called Exposure – Horizontal and the other vertical and called 
Exposure – Vertical.  Both go from green to red from 0 to 50 mg/m3 with the 
numeric value beneath the graphic.  Both the scale and units can be easily 
modified.   

4. Template – A template file will tell DashWare what gauge to use and where and 
with what data profile.  A demonstration template has been developed, called 
DemoProject_Template. 

 
 
Starting a Project 
For this manual, we will step you through starting a new project without a template.  A 
template will allow you make new overlay projects quickly if you have developed a set 
layout.  Starting without a template will allow you to have a better understanding of 
how DashWare works. 
 

1. Start the DashWare program 
2. Start a new project by clicking on File>New Project and naming the project to 

your liking.  By default the project is located in your User folder in 
Documents/DashWare Projects.  This can be changed in the Menus settings 
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Tools>Options.  When you start a new project, this is where you will be able to 
apply a template.  We have developed a template for you use called 
DemProject_Template, which can be found with the files on our website.  To 
start a project with no template, select the <none> option in the Project 
Template pull down list in the New Project window.  Click OK. 

3. Once you have a new project started, you’ll see both a standard Windows 
program menu on the upper left, but also a tabs on the right for Project, 
Synchronization, Analysis By Time, Analysis By Position, and Gauge Toolbox.  
We will only use the first two and last tabs for our project. 

4. Clicking on the Project tab will allow you to set up your project (Figure 33). 
5. First you can enter information in the Project Information area.  Here you can 

enter some notes about your project, which won’t be seen on your production.  
You can also set up starting title and ending credits.  Note that if you use a Start 
Title and End Credits, they will be played over your video so you will need extra 
footage at the beginning and/or end. 

 
 

 
Figure 33  Project set up panel of DashWare. 

 
Adding Data and Video 
 

1. Next, in the Input Settings area, you’ll tell DashWare what video and data files 
to use and how those data should be read (Data Profile). 

2. Click on the plus sign next to Video: and find and choose the video file you want 
to use.  If your video camera split your video into multiple files because of length 
issues, you will be able to merge the files here by clicking on the right arrow 
button next to the plus sign. 

3. Now you will select your data file by clicking on the plus sign next to Data 
File(s):  Browse to find your CSV file and click on it.  You will then need to 
choose a data profile to read your data.  If you have formatted your file as 
shown in , you should be able to use the DemoProfile that has been provided for 
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you.  To verify that your data are being interpreted correctly, you can click on 
the Edit Profiles button.  A data profile can also be edited by clicking on File>Edit 
Data Profiles.  If you use the data file DemDataDash.csv and the data profile, 
DemoProfile, you should be good to go without editing the profile.  If you wish to 
learn about basic editing of profiles, you can go to that section of this manual. 

 
Visualizing the Data 
Next you will need to create a visualization for your data by choosing a gauge for your 
data. 

1. Click on the Gauge Toolbox tab.  This will reveal all of the gauges that have been 
developed that you can use to show your data (Figure 34). 

2. Scroll down to the E’s for the Exposure – Horizontal and Exposure – Vertical 
gauges.  These have been developed to show exposure data in a relatively 
meaningful manner. 

3. Click on one of the exposure gauges and drag it onto the video where you would 
like it placed.  You can move and resize the gauges as you like. 

4. These gauges should already be connected to your data, if you are using the 
provided data profile and spreadsheet. 

5. The look of the gauge, numbers, and units can be altered.  Those operations will 
be discussed later.  Figure 4 shows a basic data overlay with DashWare using 
the gauge, video clip, data, and data profile provided. 
 

 
 

 
Figure 34  The Gauge Toolbox and 30 of the many gauges. 
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Synchronizing the Data and Video 
Next, your data will need to be synchronized with your video. 

1. Click on the Synchronization tab and a blue Synchronization Map will appear, 
ignore that.  At the bottom of the screen is a red oval scroll bar that can be 
pulled to show the exposure over time and control buttons. 

2. Make sure that the oval is at the far left and the “Sync with Video” (SWV) box is 
not checked.  This will allow you move the data over time without advancing the 
video.  When this box is checked, both the video and data will progress when the 
video’s play button is pressed. 

3. If your video and data are synchronized from the very start, you’ll pull both the 
video and data screens’ ovals to the far left, click the Sync with Video box and 
you’re good to go.  The video and data provided are pre-synched, so there is no 
need to adjust. 

4. If you need to adjust the synchronization and have a synchronization point (see 
the following section in this manual: Starting the recording/Synchronization), 
with the SWV box unclicked, scroll your video to the sync point.  Next, scroll 
your data to the sync point.  You should be able to see you data moving in your 
gauge.  If your gauge is not showing up, ensure that you have the “Show 
Gauges” box clicked below your video. 

5. When you have your data and video synchronized, click the SWV box.  Now 
when you scroll through your video your data should be synched to the 
appropriate point in the video. 

6. Save your project. 
 
Recording the Overlay Video 
Now you are ready to record your overlay video.   
 

1. Click File>Create Video. 
2. This will bring up a dialog box that will allow you to name and locate the 

Destination Video file and assign it a Quality, which I leave on Auto, which is the 
highest quality.  At the current time, you don’t have an option for the Encoder to 
be used (Microsoft Media Foundation) or the file type (MP4). 

3. Click Create Video and you video should be complete. 
 
Potential Issues with the Output video 
One issue seen in outputting video is that if the input video is the wrong resolution, the 
output video may be distorted, though the data gauge looks fine.  To resolve the 
situation, I have captured my video in 1080p HD (1920 x 1080), which is standard HD 
video.  If you are going to use Snagit to clip a video from another video, when outlining 
the area for capture, you’ll need to adjust the screen capture size/resolution after you 
select your capture area to 1920 x 1080.  See Figure 35 for the location of this setting 
in Snagit.  Simply type in 1920 and 1080 instead of the selected resolution.  By doing 
this, it will change the size and aspect ratio of your selection, but it will allow DashWare 
to output your video.  A work around to this would be to use your video at whatever 
resolution you had chosen and use Snagit to capture your session within DashWare.   
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Figure 35  Adjusting the capture area size/resolution in Snagit. 

 
 
 
DashWare – the details 
 
Use as a non-administrative user: 
Depending on your system, you may need administrative rights to install and possibly 
run DashWare.  As installed, the program will want to run from an administrator’s login 
account on the computer.  There may be ways to run it without getting administrative 
permissions by moving files to a different location, but you will need to discuss with 
your IT staff. 
 
Data Profile:  
Potentially any source of logged data could be used with this software, but DashWare 
needs to know how to read and interpret the data files.  The data profile gives 
DashWare those instructions.   
 

1. To create a new data profile, add your data file as previously described and click 
“Edit Profiles…”.  This will open with a default profile with your data. 

2. At the top of the Data Profile Editor, you’ll see Data Profiles and will be able to 
add a new data profile by clicking on the large plus sign.  You’ll be asked to 
name your profile and then add it.  Then you will get the Data Profile Editor 
screen (Figure 36). 

3. Next, select Comma for the Separator Settings and select your appropriate 
decimal format.  The Other Settings are advanced and won’t be covered here 
(because I don’t know what they are). 

4. When you first open the data profile editor with your data, the three red headers 
in the middle of the screen, Mark Header Line, Mark Data Start, and Use Line to 
auto-Choose Profile… will be greyed out.  To activate them click the first row of 
your file.  
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Figure 36  Data profile editor 

5. With the first row still highlighted, click Mark Header Line.  This will tell 
DashWare that your first row is the titles for your columns. 

6. Next, highlight your first row of data and click, Mark Data Start and Using Line to 
Auto-Choose Profile.  These setting will tell DashWare where your data start and 
what they look like. 

7. Next, go to the bottom right panel and click the Plus sign in Column Mappings.  
Here you will tell DashWare what type of data are contained in your file. 

8. As specified earlier (Figure 32), you should have time in your first column and 
your measurements in the second column.   

9. In Figure 37, in the Input Column box, you will select the Input Data Column pull 
down and that will give the options from the header line that you have on your 
data.  Select your time header. 

10. In the Column Mapping box, set Map to Data Category to “<Required>”.  This 
should automatically set Map to Data type to “Data Running Time, Seconds”. 
Click Add. 

11. Click the Plus sign again in the Column Mappings box to tell DashWare what to 
do with your other column. 

12. For the Input Data Column pull down, select the header name of your data 
column. 

13. In the Column Mapping box, set Map to Data Category as “Environment” and 
Map to Data Type as “Concentration (units here)” or “Noise”.  If you’re using a 
different unit of measure (e.g. ug/m3), you’ll be able to change the display of 
the gauge to reflect your reality.  Click Add, Apply, and OK. 

14. Now your overlay should be ready to view. 
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Figure 37  Data mapping editor. 

 
Gauges: 
There are many available gauges in DashWare.  Simply click the Gauge Toolbox tab at 
the top right of the program to see all of them.  The function of the out-of-the-box 
gauges vary greatly, but none of them were built to display exposures.  I have 
developed 4 gauges for use with exposures that you can copy to your gauges folder 
(see the Demo Files/Folders section above for more detail).  These gauges are named: 
 

1. Exposure – Horizontal 
2. Exposure – Vertical 
3. Exposure – Noise – Horizontal 
4. Exposure – Noise - Vertical  

 
Once the files have been copied into your gauges folder, they will appear in the Gauge 
Toolbox. 
 
You can clone, delete, and edit any gauge.  You can set/change data files and data 
types, manipulate colors, and change text.  You can consider these gauges as templates 
that you can customize to reflect the data that you are presenting. 

  
Components - A gauge can be considered to be a cluster of components, which can be 
static or dynamic (animated).  Examples of static components are unchanging text such 
as units and titles and shapes that don’t move or change such as background shapes.  
Dynamic text would include numeric display of your data and animated shapes would be 
moving bars or arrows visually showing the value of the data. 
 
Gauge Inputs – A gauge must also be connected to a data source and that is done via 
its inputs.  If your gauge shows up and your data are present but not animating when 
they should, the first thing to check is to ensure that the gauge’s input is correct.  The 

Note: When you double click on the gauge in the Gauge Toolbox, you will be 
editing that gauge.  When you double click on a gauge that has been dropped onto 
the project screen, you can only edit that version of the gauge being used for that 
project. 
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link to the data source is through the data profile and the data type.  For dynamic 
components, you’re able to assign a Value input to that component. 
 
Gauges can be complex.  The gauge shown in Figure 38 has 33 different components, 
with about half of them being dynamic. 
 

 
Figure 38 Example of a complex gauge. 

 
We will use the Exposure – Vertical gauge (Figure 39) to highlight how to edit your own 
gauges in Gauge Designer.  Basic properties (size, transparency, and rotation) of a 
gauge can be controlled in the Gauge Size area of the Gauge Designer.  You can define 
the data category and type for your gauge in the Input Name panel by double clicking 
on the entry under Gauge Inputs.  This needs to be consistent with the data and data 
profile. 
 

 
Figure 39  Exposure – Vertical gauge. 

 

 
Figure 40  Gauge Inputs screen. 
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To edit specific gauge components, you can either click on the text describing it 
beneath “Components” or you can double click on the component itself on the graphic.  
Table 5 gives a description of the components used for this moving bar chart for 
exposures shown in Figure 39. 
 
Table 5  Description of Components in Exposure – Vertical gauge 

Component Static / 
Dynamic 

What it is What can be altered 

Filled Rectangle Static Solid grey rectangle 
serving as a 
background 

Size, location, color of 
fill, rounded corners 

Rectangle Static Open rectangle as 
border (can’t have 
both line and shading 
on shapes) 

Size, location, color of 
line, rounded corners 

Text Static The units of measure Location, the text, font 
(the font, size, and 
type), color, and 
defining rectangle 

Dynamic Text Dynamic This shows the 
exposure value and 
changes over time 

Value Input, location, 
text settings, display 
format, decimal 
precision, Test Value*, 
etc.  

Animated Bar Dynamic Changes color based 
on the value.  The first 
animated bar shows 
the lower part of the 
concentration range 
and goes from green 
to orange. 

Value Input, location, 
size, data range, color 
gradient settings, Test 
Value* 

Animated Bar Dynamic Changes color based 
on the value.  The 
second animated bar 
shows the upper part 
of the concentration 
range and goes from 
orange to red. 

Value Input, location, 
size, data range, color 
gradient settings, Test 
Value* 

Rectangle Static Open rectangle as 
border outlining the 
colored bars 

Size, location, color of 
line, rounded corners 

*Test Settings/Value – This value can be used while designing the component to see 
if/how it works before completing the gauge. 

 
It should be noted in Figure 39 that some components are indented from others.  These 
indented components are “child” components of a parent “component”.  Child 
components are grouped with their parent and can be moved with their parent. 
 
To quickly alter the data source of a gauge, you can go to the Projects Gauges in the 
Project tab (Figure 33), highlight the gauge you want to alter and the press the Edit 
Gauge Input Assignment button (    ).  This will allow you to change the Data Value 
used for your gauge. 
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Synchronization: 
 Begin by clicking the synchronization tab at the top of the screen.  Your data file 
will be indicated at the top.  Moving the slider at the bottom should change your data 
value, but not the video location.  This is a way you can test that your gauge is 
working.  Move the slider to correspond with what is happening in the video.  Once you 
have the video and data synched visually, press the checkbox in the bottom left of this 
pane to sync your data and video.  The slider in this pane will immediately gray out.  
When you press play on your video the data will now follow along.   
 
Templates: 
 The last thing about DashWare is that it makes it easy to repeat a project style.  
Click file at the top left and save as template.  This will save the gauge, layout, and 
data profile for the next time you need it.  You will only need to import your video and 
data then synchronize everything and you will be finished.  Templates can also be 
shared between DashWare users for ease of use and consistent displays.  Templates are 
stored at \\ThisPC\USERID\DashWare. 
 
Saving: 
 For some computers it may be possible to go to File --> Create video.  This will 
save your video file directly.  This function is often reported broken, so you can use a 
screen capture method (OBS Studio) if DashWare video export fails. 
 
 
For additional help visit: http://www.dashware.net/faq/  
 
For DashWare, there are many helpful videos made by other users on YouTube and 
within the forums on the above site. 
 
 
  

http://www.dashware.net/faq/
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Appendix B  Race Renders Details 
Race Renders File Formats 

 
Video / Audio / Image File Formats 

Format Description File 
Extensions Compatible Platforms 

MPEG-4 and H.264 Video 
GoPro, 360fly, Replay XD, Sony Action 
Cam, Contour, and many others 

.MP4 

.MOV 

.M4V 

.3GP 

Windows + Mac 
Windows 7: Larger than 1080p may require 
Apple's QuickTime Player to be installed 

H.265 (HEVC) Video 
GoPro and others 

.MP4 

.MOV 

Windows + Mac 
Requires Windows 10 or macOS 10.13 
"High Sierra" or newer. 
Your system may also need to have 
hardware support for HEVC. 
Windows 10 users may need to 
install Microsoft's HEVC Video Extensions. 

AVCHD within MPEG Transport 
Stream 

.MTS 

.M2TS 
Windows + Mac 
Requires Windows 8 or macOS 10.12 
"Sierra" or newer 

QuickTime® Video .MOV 
.QT 

Windows + Mac 
Windows: May require Apple's QuickTime 
Player to be installed 

Windows Media Video .WMV 
.ASF Windows only 

MPEG-1 and MPEG-2 
MPEG-1/2 are old formats and are not recommended for 
new video 

.MPG 

.MPEG Mac only 

Audio Video Interleave (AVI) 
AVI is a very old and problematic format, and is not 
recommended for new video 

.AVI 
Windows only 
System must have compatible VfW codecs 
installed 

  

360° Panoramic Video 
Supports common 2:1 equirectangular 
format (used for YouTube, Facebook, and others) 
Supports raw footage from 360fly and 
similar fisheye 360 degree cameras 
See compatible video file formats above 

Various 
Typically .MP4 or 
.MOV 

Windows + Mac 
Windows 10 or macOS 10.10 "Yosemite" 
are required for certain capabilities 
Windows 7: Video input may require 
Apple's QuickTime Player to be installed 

  

MP3 Audio .MP3 Windows + Mac 

MPEG-4 Audio .M4A Windows + Mac 

Wave Audio .WAV Windows + Mac 

https://www.microsoft.com/en-us/p/hevc-video-extensions/9nmzlz57r3t7
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Windows Media Audio .WMA 
.ASF Windows only 

  

Common Image File Formats 
JPEG, Bitmap, GIF, PNG 

.JPG 

.JPEG 

.BMP 

.GIF 

.PNG 

Windows + Mac 

Please also see the system requirements for information on supporting these media 
formats and codecs. RaceRender may not be compatible with DRM-protected or other 
restricted-use media. 
Windows Users: RaceRender's 64-bit option may have different media support than 32-
bit. Please try the 32-bit version of RaceRender if encountering problems. 
 
Data File Formats 

Format Description File 
Extensions 

GPS Loggers - NMEA, GPX, TCX, and FIT Formats 
Common GPS recording formats used by Garmin and many other products 
 
Known Compatible Product List 
 
Additional Information 

.NMEA 

.GPX 

.TCX 

.FIT 

.TXT 

.LOG 

GPS-Enabled Cameras - NMEA Embedded in Video File 
GPS data inside an MP4 or MOV file 
 
Known Compatible Product List 
 
Additional Information 

.MP4 

.MOV 

Motorsports and Other Dataloggers - CSV and Text 
Formats 
Many data acquisition systems and dataloggers 
 
Known Compatible Product List 
 
Additional Information 

.CSV 

.VBO 

.TXT 

.LOG 

Compatibility and available data features will depend on the format, data, and 
functionality provided by these other products, which may change at any time and 
without notice. 
 

https://racerender.com/RR3/docs/Dataloggers-Simple.html
https://racerender.com/RR3/docs/HowTo-Datalogger.html#Generic
https://racerender.com/RR3/docs/Dataloggers-Simple.html
https://racerender.com/RR3/docs/HowTo-Datalogger.html#Generic
https://racerender.com/RR3/docs/Dataloggers-Simple.html
https://racerender.com/RR3/docs/HowTo-Datalogger.html
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Output File Formats 
 

Name Extension Platforms Notes 

MPEG-4 H.264 .MP4 Windows + 
Mac 

Supports Google 360 degree spherical 
metadata (for YouTube, Facebook, and 
others) 
 
Windows Version 
Up to 4K is supported on Windows 10 
High Profile is supported on Windows 8 
and newer 
Windows 7 may have limited quality 
 
macOS Version 
Up to 4K is supported on macOS 10.10 
(Yosemite) and newer 
High Profile is supported on macOS 10.9 
(Mavericks) and newer 

Windows Media 
Video .WMV Windows 

Only 
Uses Windows Media 9 codec 
Up to 4K is supported 

Audio Video 
Interleave (AVI) .AVI Windows 

Only 

Up to 720x480 video, audio is PCM 
format, Xvid codec is recommended if 
using AVI 
AVI is not recommended for normal use 

 
 
System Requirements 
Please note that processing larger than 1080p video (such as 4K) will naturally consume more 
system resources, take longer to render, and may require the latest operating system version for 
some capabilities. Whenever you double the video height and width resolution, it quadruples the 
number of pixels that need to be decoded, loaded into memory, processed, and finally re-encoded. 
Similarly, high video frame rates can greatly increase how often this needs to be performed. As a 
result, increased video resolutions and frame rates can have a large impact on performance and 
practical system requirements. See Chart 
 
In other words, for the latest and greatest video resolutions and features, you may find that you want 
to be using a computer with the latest and greatest performance, or something close to that. 
 
Windows Version 

• OS: Microsoft Windows® 7, 8, or 10 
Windows 10 64-bit is strongly recommended. 
Windows RT, S, and Phone are not supported. Must be desktop version for Intel and AMD 
CPU's (x86 or x86-64 / x64). 
Windows 7 has less media support and capability than newer versions. 

• CPU: Intel i5, i7, or Xeon E5 CPU recommended 
Intel i7 or better strongly recommended for video larger than 1080p (ie 2.5K, 4K, etc.), or 
when using multiple 1080p videos. 
Actual requirements and performance will vary depending on use. 

http://www.xvid.org/Downloads.15.0.html
https://racerender.com/RR3/docs/Troubleshooting.html#PerfCost
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• RAM: 4 GB or more recommended 
Actual requirements will vary depending on use 
Use the 64-bit version of this software to make full use of your system's memory. 

• Display: 1280 x 720 (720p) or larger screen resolution 
1920 x 1080 (1080p) or larger is recommended. 
More needed if using screen size scaling or "Large Fonts" (common for high-DPI screens). 

• Windows 10 users may need to install Microsoft's HEVC Video Extensions, and have 
compatible hardware, in order to use H.265 / HEVC videos. 

• Windows 'N' or 'KN' edition users need to have installed Microsoft's Media Feature Pack 
This applies to certain European and Korean versions of Windows that come without media 
support. 
You may need to locate the correct media feature pack for your version of Windows. Please 
refer to Microsoft's website for assistance. 

• Windows 7 users need to have installed Microsoft .NET Framework 4 
• Optional: Apple QuickTime® 7 Player 

Mostly helpful for boosting media format support on Windows 7. 
QuickTime can only be utilized while using the 32-bit version of this software. 

• 32-bit and 64-bit versions are included 
64-bit is recommended for normal use on Windows 8 and newer. This requires a 64-bit 
version of Windows. 
 

• The 32-bit option can be useful for better media compatibility on Windows 7, and for users 
with 32-bit versions of Windows. 
32-bit may experience problems with projects that use a very large amount of memory 
(RAM). Please use 64-bit if you can. 

 
Macintosh Version 

• OS: Apple macOS® 10.9 (Mavericks) or newer 
macOS 10.14 (Mojave) is recommended. 

• CPU: Intel i5, i7, or Xeon E5 CPU recommended 
Intel i7 or better strongly recommended for video larger than 1080p (ie 2.5K, 4K, etc.), or 
when using multiple 1080p videos. 
Actual requirements and performance will vary depending on use. 

• RAM: 4 GB or more recommended 
Actual requirements will vary depending on use. 

• Display: 1280 x 720 (720p) or larger screen resolution 
1920 x 1080 (1080p) or larger is recommended. 
More needed if using screen size scaling (common for high-DPI screens). 

• This is a 64-bit application 
  

https://www.microsoft.com/en-us/p/hevc-video-extensions/9nmzlz57r3t7
https://support.microsoft.com/en-us/kb/3099229
http://www.microsoft.com/en-us/download/details.aspx?id=17718
http://www.apple.com/quicktime/download/
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Appendix C  Different version and features of 
RaceRender 
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